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Chapter 1 - Introduction to “CDC EZ-Text”
1.1

Background

Many research projects require the collection of semi-structured qualitative data. This
includes situations where interview guides containing a series of open-ended questions are
consistently administered to each person in the sample, though the content, length, and
complexity of responses to the questions may vary widely between respondents. For
example, HIV/AIDS risk behavior studies sponsored by the Centers for Disease Control
and Prevention (CDC) frequently use semi-structured interview instruments. These
instruments typically include 20 to 50 open-ended questions, and sample sizes may include
several hundred individuals residing in multiple communities. Some projects utilize as
many as 20 or 30 different interviewers. Written summaries or verbatim transcripts from
tape recordings are generated following each interview, and the final computerized
databases contain hundreds and sometimes thousands of pages of text.
One challenge in conducting this type of research concerns the organization and
management of the data prior to analysis. Multiple interviewers may work on different
Windows™ or Macintosh® platforms; conversion of files between systems can be timeconsuming. Even when all research staff use the same platform, variations in margin, font,
and other preferences affect the physical data organization. Also, response segments
relevant to a specific question may be placed in different locations within the write-up for
each respondent. Further complications occur when interviewers make independent
changes to the data collection protocol, such as altering the number, wording, or intention
of the questions on the interview guide.
Under these conditions, it is difficult for study coordinators to monitor and ensure the
consistency of data collection and write-up across the sample. Even when interviews are
conducted in a comparable manner, inconsistent organization of the interview notes may
mean that study coordinators must reformat the data into a standard layout prior to
analysis. Not only does this waste financial resources and staff time, it causes delays in
generating research findings. Occasionally, these barriers are so large that the data are
never fully analyzed.
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1.2

Summary of “CDC EZ-Text” Functions

“CDC EZ-Text” Version 3.06 (EZ-Text) is a new qualitative software program developed
to assist researchers in creating, managing, and analyzing semi-structured qualitative
databases. EZ-Text helps solve the problem of consistency across interview write-ups by
allowing a researcher to design a series of qualitative data entry templates tailored to
his/her questionnaire. Data can be typed directly into the templates or copied from word
processor documents and can accommodate special non-English alphabet characters such
as: Ö, Æ, Ø, é, á, í, ó, and ñ. Following data entry, investigators can create on-line
codebooks, apply codes to specific response passages, develop case studies or case series,
conduct database searches to identify text passages that meet user-specified conditions,
and export data in a wide array of formats for further analysis with other qualitative or
statistical analysis software programs. Project managers can merge data files generated by
different interviewers for combined cross-site analyses. The ability to export and import
the codebook helps to coordinate the efforts of multiple coders simultaneously working
with copies of the same database file.

1.3

Notice to Users

EZ-Text was jointly designed and developed by staff from Conwal Incorporated and the
Centers for Disease Control and Prevention (CDC). Its primary purpose is to help meet
CDC's own public health research needs. Other investigators may determine that the
program is useful for different purposes. However, neither CDC nor Conwal
Incorporated make any expressed or implied guarantees that this software program will be
an appropriate or useful tool for addressing the needs of other potential users. No
warranty is made or implied for the use of the software for any particular purpose. CDC,
Conwal Incorporated, and their staff or subcontractors are not responsible or liable in any
way for any consequences resulting from the use or misuse of the EZ-Text program or its
documentation.
The EZ-Text software program and its associated documentation are in the public domain;
they may be freely copied and distributed without restriction. However, potential users
should understand that there is no formal mechanism available for technical support
beyond the help files included with the program installation diskettes. To obtain a copy of
“CDC EZ-Text” Version 3.06 free of charge, researchers can copy installation disks from
the CDC web site:
http://www.cdc.gov/nchstp/hiv_aids/software/ez-text.htm
Trade names are used for identification purposes only or for examples; no endorsement of
particular products is intended or implied. The use of trade names or trademarks in the
EZ-Text documentation does not imply that such names, as understood by the Trade
Marks and Merchandise Marks Act, may be used freely by anyone.
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1.4

Suggested Citation for CDC EZ-Text
Carey, James W.; Wenzel, Patrick H.; Reilly, Cindy; Sheridan, John; Steinberg, Jill
M.; and Harbison, Katherine G. (1998). “CDC EZ-Text”: Software for
Collection, Management and Analysis of Semi-structured Qualitative Databases
(Version 3.06). Atlanta: Developed by Conwal Incorporated for the Centers for
Disease Control and Prevention.

1.5

Suggested Applications

A central assumption behind the design of the EZ-Text program is that the user wishes to
examine the same set of topics with each individual in his/her sample. As noted above,
this may entail use of the same semi-structured interview instrument with each respondent.
EZ-Text might also be used to collect and analyze semi-structured behavioral observation
data.
However, EZ-Text is not likely to be very helpful to researchers administering highly
unstructured ethnographic studies where the set of discussion topics or behavioral
observation categories vary greatly among each person in the sample. Similarly, EZ-Text
is not a substitute for statistical analysis software. In our view, EZ-Text helps address a
specific set of needs related to semi-structured qualitative data, especially when it is
collected and coded by different individuals following a common protocol on a multi-site
research project. If investigators do not wish to generate and analyze a semi-structured
qualitative database, we recommend that they choose a different software tool (Weitzman
and Miles 1995).
If your needs include the use of this software tool, then follow the simple instructions in
this guide.
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Chapter 2 - Technical Features and Requirements
2.1

Program Language and Operating Platforms

The program for EZ-Text was written in Visual Basic ®. It uses Microsoft Access®
database structure, which means that all database file names must have a ".mdb" extension.
EZ-Text runs on Windows™ 3.1, Windows™ for Workgroups 3.1, Windows™ 95, and
Windows™ NT (versions 3.51 and 4.0) operating platforms. There are no plans to
develop versions for Macintosh® or other systems.

2.2

Computer Hardware

It is recommended that EZ-Text be installed on computers with moderately fast Pentiumcompatible processors (e.g., 100MHz or higher speed) that have at least 16 MB of RAM.
The program may work on less powerful computers, but users may exceed system
resources when working with large files. Databases can become large, and the computer
must be able to work with large files. For example, a database for a study with 30 openended questions containing all the coded response text passages for 70 respondents may
equal or exceed 1 or 2 MB in size. Use of EZ-Text on weak or out of date computers
may result in poor performance, system crashes, or data loss.

2.3

Importance of Backing Up Databases

As with other applications, it is strongly recommended that users always copy their data
files to back-up locations on a regular basis (e.g., copy the database to a separate file
named for the date or day of the week after each work session). EZ-Text simplifies this
process by automatically asking the user if he/she would like to make a back-up copy.

2.4

Other Technical Features

Version 3.06 of EZ-Text is not designed for simultaneous use by multiple users on a LAN.
Future versions of EZ-Text will address this limitation. However, the program can be
independently installed on the local hard drives at different work sites or multiple
computers on a LAN. Files created on separate computers can be merged, provided that
each user has employed identical data entry templates and there is no overlap of
respondent ID numbers. Once a template file has been finalized, and copies are distributed
to research team members, a password system prevents unauthorized personnel from
making independent modifications. This helps guarantee that templates used for data
entry on different computers remain comparable and can later be merged. A second
password system protects the content of the codebook, which helps ensure that multiple
coders use identical coding instructions during data analysis.
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Chapter 3 - Installation and Operations of EZ-Text
3.1

How to Install CDC EZ-Text

For Windows 95/ Windows NT Users:
Step 1: There are three “CDC EZ-Text” Setup disks. Insert the first Setup disk
(Disk 1) in the 3 ½” drive.
Step 2: Click on the Start button on the bottom Taskbar, point to Settings, then
click Control Panel.
Step 3: Double-click on Add/Remove Programs.
Step 4: Click on the Install button and follow the instructions on the screen.
Note:

It is strongly recommended that “CDC EZ-Text” be installed in the
default directory (C:\EZTEXT30). If “CDC EZ-Text” is installed in a
different directory, the EZTEXT30.INI file located in the main
operating system directory (usually C:\WINDOWS) will need to be
modified to reflect the new path.

For Windows 3.1 Users:
Step 1: There are three “CDC EZ-Text” Setup disks. Insert the first Setup disk
(Disk 1) in the 3 ½” drive.
Step 2: Select the Run command from the File Menu within File Manager.
Step 3: Type a:\setup in the Run dialog box. (Type b:\setup if the 3 ½” drive
is referred to as B.)
Step 4: Press the Enter key or click on the OK button. Follow the instructions
on the screen to install EZ-Text.
Note:

It is strongly recommended that “CDC EZ-Text” be installed in the
default directory (C:\EZTEXT30). If “CDC EZ-Text” is installed in a
different directory, the EZTEXT30.INI file located in the main
operating system directory (usually C:\WINDOWS) will need to be
modified to reflect the new path.
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3.2

Start-up and On-line Help Documents and Files

Click on the EZ-Text icon. When EZ-Text opens, a credits box appears and automatically
closes. Following this, the Help File can be opened via the Menu Bar at the top of the
screen. The Help File (named “eztext30.hlp”) is automatically installed with the EZ-Text
program and provides basic instructions on how to use the program. The Help File can
be printed directly from EZ-Text or opened in any word processor.
To access the Help File:
Step 1: Click on Help on the Menu Bar. The Menu Bar is located at the
top of the screen. (See figure 3.2-1.)
Figure 3.2-1

Opening the Help File

Step 2: The Help File will appear on the screen. Click on the Command
Buttons, which appear at the bottom of the screen, to navigate through
the Help File. The Command Buttons can also be accessed by using the
Tab key on the keyboard. (See figure 3.2-2.)
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Figure 3.2-2

Help File Command Buttons

Step 3: To exit the Help File, click on the Cancel Command Button.

3.3

Applications of an Existing Database

After the opening credits box automatically closes, other instructions, found at the bottom
of the screen, describe the initial steps for defining a new database or accessing an existing
database. The rest of this chapter provides directions for different applications of existing
databases, and briefly discusses control functions within those databases. Instructions for
creating a new database are addressed in Chapter 5.

3.3(a) Opening an Existing Database File
To open an existing database file:
Step 1: Click on File on the Menu Bar.
Step 2: Click on Open Database on the File Menu. (See figure 3.3-1.)

7

Figure 3.3-1

Opening a Database

Step 3: A list of saved documents will appear. Highlight the name of a
previously-saved database file and click on OK. Alternatively,
type the name of the database file at the prompt and click on OK.
(See figure 3.3-2.) If the file to be opened does not appear in the
list of files, select the appropriate drive and folder. To select a
drive, click on the arrow to the right of the drive field, and select
the needed drive from the pull-down menu by clicking on the
drive. To select a folder, scroll down the list of folders, and
double-click on the folder needed.

8

Figure 3.3-2 Selecting a database file to open

After selecting the desired file, the Interview Information Screen will load, and the first
respondent record will appear on the screen.
An example of an EZ-Text database is automatically installed with the EZ-Text program.
The example database can be used to learn the functions of EZ-Text described in this
manual.
To open the Example Database:
Step 1: Click on File on the Menu Bar.
Step 2: Click on Open Database on the File Menu.
Step 3: Highlight example.mdb under File name, and then click on OK. (See
figure 3.3-3.)
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Figure 3.3-3

Opening the Example Database

The example database is now open. (See figure 3.3-4.)
Figure 3.3-4

Example Database
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3.3(b) Deleting an Existing Database File
To delete an existing database file:
Step 1: Click on File on the Menu Bar.
Step 2: Click on Delete Database on the File Menu. (See figure 3.3-5.)
Figure 3.3-5 Deleting a Database

Step 3: A list of previously-saved documents will appear. Highlight the
name of the database file to be deleted, and click on OK.
Alternatively, type the name of the database file at the prompt and
click on OK. (See figure 3.3-6.) If the file to be deleted does not
appear in the list of files, select the appropriate drive and folder.
To select a drive, click on the arrow to the right of the drive field,
and select the needed drive from the pull-down menu by clicking
on the drive. To select a folder, scroll down the list of folders,
and double-click on the folder needed.
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Figure 3.3-6

Selecting a Database File to Delete

Step 4: After the database file has been deleted, a screen will appear
informing the user that the file deletion was successful. Click on
OK. To return to the Home Screen, click on Cancel.

3.3(c) Copying and/or Renaming an Existing Database File
To copy and/or rename an existing database file:
Step 1: Click on File on the Menu Bar.
Step 2: Click on Copy or Rename Database on the File Menu. (See
figure 3.3-7.)
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Figure 3.3-7

Copying and/or Renaming a Database File

Step 3: A screen with two columns of fields will appear. The column on
the left displays a list of files from a Source Folder, a list of
Source Folders, and the Source Drive. The column on the right
displays a list of files from a Target Folder, a list of Target
Folders, and the Target Drive. From the list of files above Source
Folders, highlight the file to be copied and/or renamed. (See
figure 3.3-8.) If the file to be copied does not appear in this list
of Source Files, select the appropriate Source Drive and Source
Folder. To select a Source Drive, click on the black arrow to the
right of the Source Drive field, and select the needed drive from
the pull-down menu by clicking on the drive. To select a Source
Folder, scroll down the list of Source Folders, and double-click
on the folder needed.

13

Figure 3.3-8

Selecting a Database File to Copy

Step 4: Select the folder, in the right-hand column, into which the
database file will be copied (Target Folder). To select the Target
Folder, double-click on the top folder in the Target Folder field.
Scroll down the list of folders, and double-click on the folder
needed. If it is necessary to change the Target Drive, click on the
black arrow to the right of the Target Drive field, and click on the
appropriate drive. (See figure 3.3-9.)
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Figure 3.3-9

Selecting the Target Folder

Step 5: After selecting the Target Folder, type the name of the database
file in the field under Target File Name. If you are renaming the
database file, type in the new name ending with an .mdb or .bak
extension. Click on OK. A screen will appear to inform the user
that the file was successfully copied. Click on OK. To return to
the Home Screen, click on Cancel. (See figure 3.3-10.)
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Figure 3.3-10

Naming the Database File to be Copied

Note: If the user wants to rename a database file in the same folder, make sure the Target
Folder is the same folder as the Source Folder. (See figure 3.3-11.) When a file is
renamed, the original file will still exist. To delete the original file, see section 3.3(b).
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Figure 3.3-11

Renaming a Database File in the Same Folder

3.3(d) Moving an Existing Database File
To move an existing database file:
Step 1: Click on File on the Menu Bar.
Step 2:

Click on Move Database on the File Menu. (See figure

3.3-12.)
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Figure 3.3-12 Moving a Database File

Step 3: A screen with two columns of fields will appear. The column on
the left displays a list of files from a Source Folder, a list of
Source Folders, and the Source Drive. The column on the right
displays a list of files from a Target Folder, a list of Target
Folders, and the Target Drive. From the list of files above Source
Folders, highlight the file to be moved. (See figure 3.3-13) If the
file to be moved does not appear in this list of Source Files, select
the appropriate Source Drive and Source Folder. To select a
Source Drive, click on the black arrow to the right of the Source
Drive field, and select the needed drive from the pull-down menu
by clicking on the drive. To select a Source Folder, scroll down
the list of Source Folders, and double-click on the folder needed.
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Figure 3.3-13

Selecting a Database File to Move

Step 4: Select the folder, in the right-hand column, into which the
database file will be moved (Target Folder). To select the Target
Folder, double-click on the top folder in the Target Folder field.
Scroll down the list of folders, and double-click on the folder
needed. If it is necessary to change the Target Drive, click on the
black arrow to the right of the Target Drive field, and click on the
appropriate drive. (See figure 3.3-14.)
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Figure 3.3-14

Selecting the Target Folder

Step 5: After selecting the Target Folder and the file to be moved, click
on OK. A screen will appear to inform the user that the file was
successfully moved. Click on OK. To return to the Home
Screen, click on Cancel.

3.3(e) Restoring a Backup Copy of an Existing Database File
To restore a backup copy of an existing database file:
Step 1: Click on File on the Menu Bar.
Step 2: Click on Restore Backup on the File Menu. (See figure 3.3-15.)
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Figure 3.3-15

Restoring a Backup

Step 3: The Restore Backup File Screen will appear. Select the folder
that holds the backup file to be restored. To select a folder,
double-click on the top folder in the Folder field. Scroll down the
list of folders and double-click on the appropriate folder. The list
of backup files within the chosen folder will appear in the second
field under File name. (See figure 3.3-16.)
Figure 3.3-16

Selecting a Folder
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Step 4: Highlight the name of the backup file to be restored and click on
OK. Alternatively, type the name of the backup file at the prompt
and click on OK. (See figure 3.3-17.)
Figure 3.3-17

Selecting a Backup File

Step 5: If the backup file has the same name as the .mdb or original file, a
warning will appear on the screen. (See figure 3.3-18.) If the
restoration of the backup file is continued, the .mdb file will
be overwritten. To avoid overwriting the original file with
the backup file, rename either the original file or the backup
file. See section 3.3(c). If the user chooses to proceed and
overwrite the original file, click on Yes on the Warning Screen.
Figure 3.3-18

Overwrite Warning

Step 6: Once the user is ready to restore a backup copy and clicks on OK
from the Restore Backup File Screen, a screen will appear
confirming the backup file has been restored. (See figure 3.3-19)
Click on OK. To return to the Home Screen, click on Cancel.
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Figure 3.3-19

3.4

Backup Restored

Menu Bar and Command Buttons on the Interview Information Screen

After opening a file, the user will see two sets of control functions: the Menu Bar (the bar
at the top of the screen) and the Command Buttons (the buttons at the bottom of the
screen). The Menu Bar commands can be accessed either by clicking on them using the
mouse, or by pressing the Alt key in combination with the underlined letter of the
command on the Menu Bar. Each menu accesses a list of commands or functions which
will be subsequently described in this manual.
The Command Buttons are accessed simply by clicking on them. Move the mouse until
the cursor is over a Command Button, and click the left mouse button once. Or use the
Tab key to move through the Command Buttons. The Command Buttons generally
function as labeled (i.e., First moves to the first record in the database, Last moves to the
last record in the database).
Located between the Menu Bar and the Command Buttons is a series of Interview
Information fields which describe key features of the study and each respondent. Two of
these fields are required for all EZ-Text database files: a descriptive study name and a
respondent identification number. The length and content of these two fields are userdefined. The other fields are optional, and might include variables such as the
interviewer's name, date and location of the interview, age and gender of the respondent,
etc. The user-defined names (up to 20 characters long) for these fields appear to the left
of the corresponding box. The boxes are filled in for each respondent during data entry.
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Chapter 4 - Data Entry
4.1

Adding a New Respondent ID Number to a Database

To add a new respondent to a database:
Step 1: Click on the New Command Button at the bottom of the screen or
select New on the Record Menu at the top of the screen.
(See figure 4.1-1.)
Figure 4.1-1

Adding a New Respondent

Step 2: The New Respondent ID dialog box will appear. Enter a unique
respondent identification number (ID). The ID must be a number (i.e.,
no letters or special characters). (See figure 4.1-2.)
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Figure 4.1-2

New Respondent ID

Step 3: Press the Enter key or click the Continue button.
Once saved, an ID number cannot be modified in the current version of EZ-Text. This
helps avoid accidental changes being made to the ID. However, ID numbers, along with
their corresponding data, can be deleted from the database. After entering a new ID, it is
compared with existing records. If the number has already been used or is not within a
user-defined permissible value range, the user is prompted to correct the ID before it can
be saved.

4.2

Entering and Saving Data in the Interview Information Fields

Assuming the new ID is valid, EZ-Text returns to the Interview Information Screen.
To enter data into these fields:
Step 1: A blinking cursor will appear in the field next to Respondent Name.
Type the data in the blank field (box).
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Step 2: To move from field to field, use either the mouse and click on the
desired field or press the Tab key on the keyboard. (Shift/Tab will move
in the opposite direction, from field to field.) When the blinking cursor is
in the desired field, enter the data.
Step 3: Some fields may have a pull down menu from which to choose a
response. These fields will have a black arrow to the right of the field.
Click on the arrow and highlight the correct response or use the arrow
keys on the computer keyboard. (See figure 4.2-1.)
Figure 4.2-1

Selection List

Step 4: After filling in the blank fields with the appropriate data for the
respondent, click on the Save Command Button at the bottom of the
screen.
If the user forgets to save the data and attempts to move to the Questions Screen, add a
new ID, or move to a different ID, EZ-Text prompts the user to save the data before
moving on.
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4.3

Entering and Saving Data for Open-ended Questions

To enter responses to open-ended questions:
Step 1: Click on the Questions Command Button at the bottom of the
screen. This brings up the first open-ended question screen. The top of
the screen shows the respondent’s ID, the text of the question, and a new
Menu Bar which accesses various editing functions. Details on the
editing functions can be found in section 4.4. The bottom of the screen
contains a new set of Command Buttons. (See figure 4.3-1.)
Figure 4.3-1

Open-ended Question

Step 2: Below the ID and the question is an empty box. Type the text of the
response to the first question here. If the data have been typed into a
word processor document (e.g., a verbatim transcript of an interview),
toggle back and forth between the word processor and EZ-Text to copy
blocks of text relevant to the question. (See section 4.4.) Alternatively,
the Import Text File function can be used to copy data from a word
processor document (see chapter 8). A scrolling feature allows for long
passages if the length of the response exceeds the initial space shown in
the box on the screen. To use the scrolling feature, click on the down
arrow to move down in the question text, or click on the up arrow to
move up in the question text. (See figure 4.3-1.)
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Step 3: If there is no response to a question, do not leave it blank. On the top
left corner of the Menu Bar there is an Other Response option. Click on
this item to display a menu with three options: Not Applicable, Question
Not Asked, and Respondent Did Not Answer. Highlight the appropriate
response to fill in the question text box. (See figure 4.3-2.)
Figure 4.3-2

Other Responses

Step 4: After answering each question, there is an option for checking and
correcting the spelling by clicking on the Check Spelling Command
Button. (See figure 4.3-3.) The Spell Check function can also be
accessed from the Agents Menu on the Interview Information Screen
Menu Bar. Details on the Spell Check Agent can be found in section 7.5.
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Figure 4.3-3

Check Spelling Command Button

Step 5: After answering the first question, click on the Next Question button to
continue with the remaining questions.
Step 6: Each time Next Question is clicked, the text of the current question is
saved. When Next Question is clicked after all questions have been
entered, a prompt will appear informing the user that the last question has
been reached. Click on OK, and then click on Return to Main. The
program will return to the Interview Information Screen. To add another
respondent, repeat steps 1 through 6.

4.4

Editing Responses to Open-ended Questions

To edit responses of open-ended questions:
Step 1: From the Interview Information Screen, click on the Questions
Command Button. This brings up the first open-ended question.
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Step 2: On the Menu Bar, click on Edit. (See figure 4.4-1.) From the Edit
Menu, the user can cut, copy, paste, or delete the response to a question.
Figure 4.4-1

Edit Menu

Step 3: Highlight the portion of the response text that needs to be edited. (See
figure 4.4-2.)
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Figure 4.4-2

Highlighting text to be edited

Step 4: Use the appropriate edit commands from the Edit Menu to edit the text
of the response.
Cut - removes the highlighted text from one document or response and
places the removed text into the clipboard to be pasted into a
different document or response.
Copy - makes a copy of the highlighted text and places it in the clipboard
to be pasted into a different document or response.
Paste - takes previously cut or copied text from the clipboard and places
the text into a different document or question.
Delete - completely removes the highlighted text from a document.
The editing functions available in EZ-Text are also available in word processing programs.
This allows the user to toggle back and forth between the word processor and EZ-Text to
copy blocks of text relevant to the question.
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4.5

Limits on Length of Responses to Open-ended Questions

Depending in part on the user’s computer hardware limitations, most users will probably
be able to save as much as 35,000 to 40,000 bytes of information in the response box for
one question, for one respondent (i.e., a text passage roughly equivalent to a
WordPerfect 6.1 file containing 8 to 10 single-spaced pages). However, long responses
for a single question are cumbersome during subsequent coding and analysis. Therefore, it
is strongly recommended that users enter smaller response segments into a response box
for a specific question. If necessary, multiple templates can be created for managing
complex, open-ended questions that have subtopics. Based on experience with EZ-Text,
response segments equivalent to half a page or less in length within a single-spaced word
processor document are easiest to enter, code, and analyze.

4.6

Automatic Save and Restore Original Functions

When entering data on the Question Screen, records are automatically saved before
moving to another open-ended question, or when returning to the Interview Information
Screen. If a user incorrectly modifies a response, the Restore Original Command Button
can be used to bring back the original text before moving to another question. However,
once changes to a response have been saved, the previous text cannot be restored.

4.7

Completing Data Entry and Editing Existing Records

After completing data entry for the first open-ended question, the user can move to the
next question by clicking on the Previous Question, Next Question, and Goto Question
Command Buttons at the bottom of the screen. Data entry for the Interview Information
fields and the other open-ended questions is repeated until all the information has been
entered for all the respondents. Users can edit, add, or delete records as needed, except
the Respondent ID Number in the Interview Information Screen.
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Chapter 5 - Creating a New Database
5.1

Steps in Creating a Database

It is recommended that a single researcher (e.g., study project manager) create the new
templates and edit the existing templates contained in a database to avoid confusion. This
entails six steps:
(1) Opening the Administration Screen,
(2) Providing EZ-Text with a new database file name,
(3) Completing the Study Information fields,
(4) Defining each open-ended question from the questionnaire,
(5) Defining the Interview Information variables, and
(6) Setting unique passwords to protect the templates and the codebook from
unauthorized changes.

5.2

Administration Screen Overview and Default Password

To start this process:
Step 1: Close any open databases.
Step 2: Select Administration on the File Menu on the Menu Bar. (See figure
5.2-1.)
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Figure 5.2-1

Administration

Step 3: The program will prompt for the password to enter the Administration
Screens. The default password is Admin. Note: This password is
uppercase and lowercase sensitive. Enter the password into the space
provided and press Enter or click on the Continue button. (See figure
5.2-2.)

Figure 5.2-2

Administration Password

The Administration Screen will appear. The following steps will assist in allowing the user
to Create a New Database or Exit Administration.
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5.3

New Database File Names

To name a new database file:
Step 1: Click on Admin on the Menu Bar. Select Create New Database. (See
figure 5.3-1.)
Figure 5.3-1

New Database

Step 2: Enter a file name and path into the Save As dialog box. Any standard
eight character DOS file name and path is acceptable, although all file
names must have the “.mdb” extension. If a user enters the name of an
existing database, the program provides a warning prompt before it is
overwritten. Click on OK. (See figure 5.3-2.)
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Figure 5.3-2

5.4

Naming a New Database

Defining Database Structure with Administration Screen Tabs

Once the EZ-Text database has been named, the user may perform the following
functions, using the steps defined below:
(1)
(2)
(3)
(4)

define the study name in the Study Information Screen;
define open-ended questions in the Open-Ended Questions Screen;
add interview information in the Interview Information Screen; and
delete, modify, or add codes corresponding to themes present in open-ended
responses in the Codebook Screen.

To perform any of these functions, click on the appropriate tab at the top of the screen.
5.4(a) Study Information Tab
After creating an EZ-Text database, the program defaults to the Study Information
tab.
To continue:
Step 1: In the field labeled Study Name:, New Database appears.
Using the mouse, highlight New Database and then type the name
of the study. (See figure 5.4-1.)
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Figure 5.4-1

Study Information Tab

Step 2: After entering the study name, go to the Codebook Password
field. Enter the password to be used to access the codebook for
this study. The default password is Admin. For more
information concerning passwords, see section 5.5.
Step 3: Click on the Save button to save the Study Name and Codebook
Password.
This study name will be used on all reports and data entry screens. Note that the
Date Created and Date Modified fields are maintained by this program and cannot
be modified by the user.

5.4(b) Open-ended Questions Tab
The next step is to add open-ended questions to the EZ-Text database.
To add open-ended questions:
Step 1: Click on the Open-Ended Questions tab on the Administration
Screen. (See figure 5.4-2.)
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Figure 5.4-2

Open-Ended Questions Tab

Step 2: Click on the New Question Command Button.
Step 3: For each question in the database, EZ-Text prompts for the
completion of three fields: Question Sequence, Question
Number, and Question Text.
Question Sequence field - a unique decimal number which
controls the sequence in which the data entry screens will appear
to the person entering the interview data (e.g., a screen with 2.5
as its Question Sequence number appears after a screen with a
Question Sequence number of 2.0). In most cases, the values of
these numbers will reflect the order of the questions on the
original questionnaire.
Question Number field - accepts any combination of letters and
numbers (e.g., "1," "2a," "2b," "IV," etc.). These labels
correspond to the question numbering system used on the original
interview questionnaire. Typically this field would be used to
store the question identifier.
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Question Text field - used to store the actual text of the openended question as it appears on the questionnaire.
Step 4: After entering the fields for a question, click the Save button to
store the question in the database.
Step 5: Follow the above procedures to provide information for the other
open-ended questions from the questionnaire.
The other buttons on this screen can be used to move throughout the defined
questions in a database. Questions may be modified at any time after they have
been defined. Make the desired changes to the fields and click the Save button.
Note that deleting a question from the database will also delete any responses to
that question.

5.4(c) Interview Information Tab
After creating the screens for the open-ended questions, the next step entails
defining the Interview Information variables. Each EZ-Text database can have an
unlimited number of user-defined fixed length fields to store interview information.
Fixed length means fields which are limited to a set number of characters or
responses.
To define fixed length fields:
Step 1: Click on the third tab on the Administration Screen labeled
Interview Information. (See figure 5.4-3.)
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Figure 5.4-3

Interview Information Tab

By default, all EZ-Text databases have one field, ID Number, already defined.
While the field length of this field can be modified, it cannot be deleted. The field
length cannot exceed nine digits.
Step 2: The Interview Information Screen displays a grid of fixed length
fields which have been defined for a database. To add a new
field, click on the Add Field button, which displays the Add Field
Screen. (See figure 5.4-4.) Notice that the grid on the Interview
Information Screen consists of twelve rows. If the number of
fields in a template exceed twelve, a scrolling feature has been
provided at the right side of the Interview Information tab to
access more rows. (See figure 5.4-3.) To use the scrolling
feature, click on the down arrow to move down in the list of
variable fields, or click on the up arrow to move up in the list of
variable fields.
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Figure 5.4-4

Add Field

The Add Field Screen displays at least four fields depending on the “Field Type.”
If the field type is numeric, six fields are displayed.
Field Order Number - a decimal number that controls the
placement of the variable on the Interview Information Screen
(e.g., a variable with 2.5 as its Field Order Number appears after
a variable with a 2.0 Field Order Number). Note that the field
number must be greater than 1.0, which is reserved for the ID
Number field.
Field Name - stores the name of the variable (e.g., "Age," "Sex,"
"Interviewer Name," "Date of Interview," etc.). Use descriptive
field names, but limit them to 20 characters.
Field Type - defines the field as a numeric variable (e.g., age), a
text variable (e.g., interview location), or a selection list. The
selection list provides the option of creating a pull-down list of
responses. (See steps 8 through 10 on the following pages.) An
example of a selection list variable is a field called “Interview
City" that might include Atlanta, Chicago, New York, and Los
Angeles in the pull-down list of possible responses that can be
selected during subsequent data entry for a respondent.
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Field Display Length - controls the number of characters that can
be entered in the field. If the field type is numeric, the field length
can be up to 9 characters. However, if the field type is text or a
selection list, the field length can be up to 60
characters.
Step 3: Enter the Field Order Number and Field Name.
Step 4: To enter the Field Type, choose from the options in the selection
list. To activate the selection list, click the down-arrow button to
the right of the Field Type field and click on the desired choice or
use the arrow keys on the keyboard. If the Field Type is defined
as a number, two additional types of information will pop up on
the Add Field Screen: Minimum Value and Maximum Value.
These items control the minimum and maximum values that can
be entered into a field. This is helpful for ensuring valid data
entry of numeric variables.
Step 5: Enter the Field Display Length. Remember, if the field type is
numeric, the field length can be up to 9 digits. However, if the
field type is text or a selection list, the field length can be up to 60
characters.
STEP 6 IS NEEDED ONLY IF THE FIELD TYPE IS NUMERIC.
Step 6: If the field type is numeric, two extra fields will appear:
Minimum Value and Maximum Value. (See figure 5.4-5.) Enter
the minimum and maximum values allowed to be entered into the
field by data entry personnel.
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Figure 5.4-5

Minimum and Maximum Value Fields

Step 7: Click on the Save button on the Add Field Screen to save the
settings for a field. Or to cancel the addition of a field, click on
the Cancel button.
STEPS 8 THROUGH 10 ARE NEEDED ONLY IF SELECTION LIST
IS CHOSEN FOR THE FIELD TYPE.
Step 8: After saving the settings for the field, the program will prompt
the user to add the selection list values. Either add the values at
this time, or, to add them later, highlight the field on the Interview
Information field grid and click the Modify Selection List button.
Either method will bring up the Selection List Maintenance
Screen. (See figure 5.4-6.)
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Figure 5.4-6

Selection List Maintenance

Step 9: The Selection List Maintenance Screen displays the current
selection list values and provides the option of adding new values
to the list or removing existing values. To add to a selection list,
type in the list item beside New List Value and click on Add to
List. To delete an item from a selection list, highlight the item to
be deleted and click on the Remove button.
Step 10: After modifying the selection list, click on the Return button to
return to the Interview Information Screen.
Note that from the Interview Information Screen, the field order and the field
display length may be modified. To change the field name or type, delete the field
and add a new field. Caution: Deleting a field removes any data associated
with that field.
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5.4(d) Codebook Tab
The fourth tab on the Administration Screen is used to create the codebook. This
will be discussed in greater detail in the next chapter.

5.5

Changing Administration and Codebook Passwords

Administration Password
After defining an EZ-Text database, assigning it a password is strongly recommended to
protect its definition.
To assign an Administration Password:
Step 1: Select Admin on the Menu Bar and click on Change Database
Password. (See figure 5.5-1.) The Change Database Password
Screen will appear. (See figure 5.5-2.)
Figure 5.5-1

Administration Password
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Figure 5.5-2

Change Database Password

Step 2: After entering the new password and verifying it, click on the
Save button.
Note: This password is uppercase and lowercase sensitive.
Write the database password down and save it. If the database definition ever
needs to be changed, this password will be needed to gain access to the
administration system.
Codebook Password
After the codebook for the database has been written (writing the codebook will
be explained in the next chapter), protect it by setting a password.
To assign a Codebook Password:
Step 1: Click on the Study Information tab on the Administration
Screen.
Step 2: The last field on the screen is the Codebook Password field.
Type in the desired password and click on the Save button. (See
figure 5.5-3.)
Note: This password is uppercase and lowercase sensitive.
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Figure 5.5-3

Codebook Password

The administration and codebook passwords may be different (default for both is
Admin). Different passwords should be used for different database files.
After defining the database, select Exit Administration on the Admin Menu to view the
new database.
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Chapter 6 - Data Coding and Database Searches
6.1

Overview of Data Coding in EZ-Text

After the qualitative data have been entered into an EZ-Text database, users must decide
on their approach for handling data coding issues. In general, qualitative data coding
entails identification of the themes contained in specific text passages or segments
(Bernard, 1994; Gorden, 1992; Miles and Huberman, 1994). Themes may include beliefs,
experiences, or opinions that the respondent was trying to communicate in response to the
interviewer's questions. Different respondents may express the similar themes but state
their ideas in different ways, or they may hold entirely different views. The qualitative
data coding process requires that coders accurately read and comprehend similarities and
differences across various text passages, regardless of the way respondents express
themselves. Text passages containing identical themes are coded the same way, and
passages containing different themes receive different codes.
Regardless of the software package used, there are two major steps to the qualitative data
coding process: (1) text segmentation, and (2) the creation and assignment of codes. The
text segmentation step entails division of the text into manageable segments or "chunks"
of text (e.g., a paragraph or a few sentences, depending on the user's needs). Other
qualitative software programs require that the user manually place segmentation markers
within the text prior to assignment of codes. However, since EZ-Text is a software tool
specifically designed for use with semi-structured data collection instruments, the nature
of the instrument itself can be used as a basis for organizing the data. As discussed in
previous sections of this document, EZ-Text helps users create a series of templates which
correspond to each of the questions on their questionnaire. EZ-Text uses these templates
to create a single text passage or segment for each question, for each respondent in the
sample. For example, if there are 10 interview questions and 100 respondents, EZ-Text
would organize and store the data into 1000 text segments. In the EZ-Text system, the
database structure closely corresponds to the content of the original questionnaire. Data
are "presegmented" during data entry, and no further effort is needed to segment the text.
This can save researchers an enormous amount of time in database management, and
greatly facilitates question-by-question analysis.
In addition to segmentation, qualitative data analysts typically develop a set of codes
which correspond to each distinct theme that might be present in any segment. Creation
of the set of codes to be used for a qualitative database is an inductive task, based on what
the respondents have stated. This list of codes is compiled into a codebook, and the
codebook generally undergoes numerous revisions until it accurately reflects the themes
present in the database. In general, we recommend that users strive to develop codebooks
which contain lists of carefully defined codes that are all-inclusive, yet mutually exclusive,
in terms of summarizing themes present in the text. We also recommend that users
conduct formal intra- and inter-coder reliability assessments to make sure that coders are
consistently and correctly using the final codebook (Carey et al., 1996).
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EZ-Text provides an array of features which helps users develop a sophisticated
codebook, and then use the codebook to assign specific sets of codes to responses that
reflect the corresponding themes. Users can create as many different codes as they need.
For example, a moderately large database (e.g., 70 respondents, 30 questions each) may
require definition of 200 to 400 separate codes, although this depends on the desired level
of coding detail and the degree of thematic diversity present in the original data. As
described in section 6.3 of this chapter, EZ-Text users can determine which sets of these
codes reflect the themes present in each different text segment.
For each separate code, the EZ-Text codebook contains six major elements which allow
for the creation of highly detailed codebooks (See figure 6.2-2.):
(1)
(2)
(3)
(4)
(5)

A unique seven-character mnemonic code name;
A fifty-character "Brief Definition" of the code;
A "Full Definition" of the code (unlimited length);
Instructions to the coder on "When to Use" the code (unlimited length);
Instructions to the coder on "When Not to Use" the code (unlimited length);
and
(6) An "Example" of a text passage copied from the database showing one or
more situations where the text contains the theme corresponding to the code.
Finally, it is important to note that users are not required to use EZ-Text for coding the
data contained in EZ-Text database files. As with all software tools, EZ-Text has its
limitations, and other software packages may better suit a user's particular coding needs.
If a user wishes to employ a different software package for coding and analysis, it is
possible to use one of the EZ-Text Agents to export the text data into a new ASCII file,
and then import the data into another qualitative data analysis software package. (See
section 7.2.) If this is the preferred approach, the researcher could think of EZ-Text just
as a qualitative data entry and database management tool. In circumstances where EZText's analysis features do not match the user's needs and research goals, this might be the
best choice.

6.2

Defining Codes in the Codebook

Any combination of codes can be assigned to a specific response. For each entry in the
codebook, the following information can be defined: a seven-character name, a short
definition, a long definition, further instructions for when to apply or not apply the code,
and a text passage illustrating an example where the code should be used.
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To define codes:
Step 1: Go to the Administration Screen.
Step 2: Click on the Codebook tab.
Step 3: Click on the Add Code Command Button. (See figure 6.2-1.)
Figure 6.2-1

Add Code Command Button

Step 4: The Add New Code Screen will appear. (See figure 6.2-2.) From this
screen, enter the desired code, a brief description of the code, a full
description of the code, a use for the code, a way in which the code
should not be used, and an example of the code in use. EZ-Text does not
require that all six pieces of information be entered into the Add New
Code Screen, but it is recommended. Providing all of the information
that is known about a specific code will make it easier for multiple coders
to understand its meaning.
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Figure 6.2-2

Add New Code

Step 5: After entering a code and the rest of the information on the Add New
Code Screen, click on the Save Command Button. (See figure 6.2-3.)
Continue each step for each code that needs to be entered.
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Figure 6.2-3

6.3

Saving a Code in the Codebook

Access and Use of Coding Form

To start the coding process:
Step 1: Go to the Interview Information Screen.
Step 2: Click on Coding on the Menu Bar. Select Code Responses to open the
Coding Form.
Step 3: Using the pull-down lists, select which question and ID to code.
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Step 4: Boxes that display the original Question and corresponding Response
text passage for the selected respondent are also present. Below these
boxes are two more boxes which list Available Codes and Assigned
codes. The Available Codes list is used to scroll through the code names
and short definitions in the codebook. After reading and identifying
themes in the response passage, highlight the appropriate code in the
Available Codes list and click on the top arrow button to move the code
to the Assigned box. This process is repeated until the Assigned box
contains a list of codes corresponding to all the themes in the response.
Similar steps, invoking the bottom arrow button, are used to remove a
code from the Assigned box. (See figure 6.3-1.)
Figure 6.3-1

Coding Form

Viewing details of a code:
If the user needs to view the code along with the code’s definitions and uses, double-click
on the specific code from either the Available Codes box or the Assigned Codes box. The
Code Display Screen will appear. To return to the Coding Form, click on Return.
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To seek a code from the Available Codes box:
To find a specific code within the list of Available Codes, enter the code into the Seek
Code field near the bottom of the Coding Form. (See figure 6.3-2.)

Figure 6.3-2

Seek Code

Note: The Available Codes list is displayed in alphabetical and numerical order based on
the seven-character code names. Users can have as many codes in the codebook as they
need. (e.g., just a few codes or even hundreds of codes). A scroll bar automatically
appears on the right side of the Available Code list when there are more codes than fit in
the display box on the screen. (See figure 6.3-2.)

6.4

Viewing and Printing the Codebook

The codebook can be viewed and/or printed in abbreviated or complete formats.
To view and/or print the codebook:
Step 1: Go to the Coding Form as instructed in section 6.3.
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Step 2: Click on Reports on the Menu Bar and select the type of report to be
printed. (See figure 6.4-1.)
Figure 6.4-1

Report Selection

After assigning codes to a response the following codebook options can be viewed
and/or printed:
Response Coding Report - displays the response to one question, for one
respondent, and the assigned codes.
Codebook Summary Report (sorted by code) - displays all of the available
codes and their short definitions, alphabetized by the codes.
Codebook Summary Report (sorted by description) - displays all of the
available codes and their short definitions, alphabetized by the
descriptions.
Codebook Report - displays the entire codebook.
Step 3: Once the report type is selected, the report can be viewed on screen. To
print the report, click on the appropriate Print Command Button at the
bottom of the Print Preview Screen. (See figure 6.4-2.)
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Figure 6.4-2

6.5

Print Command Button

Modifying the Codebook

Modification of the codebook can be accomplished by one of two methods.
Method 1:
Accessing the codebook editing functions in the Administration Screen:
Step 1: Go to the Administration Screen.
Step 2: Click on the Codebook tab. (See figure 6.5-1.)
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Figure 6.5-1

Modifying Codebook in Administration

Step 3: To modify an existing code, click on the code displayed in the Codebook
tab. This will highlight the code and the short definition of the code.
(See figure 6.5-2.)
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Figure 6.5-2

Highlighting a Code

Step 4: Click on the Modify Code Command Button. This allows the user to edit
a code, the definitions of a code, or the uses or examples of a code, on
the Modify Code Screen. (See figure 6.5-3.)
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Figure 6.5-3

Modify Code

Step 5: Once the editing of the code is complete, click on the Update Command
Button. (See figure 6.5-3.) Repeat this process for as many codes as
needed.
Deleting a code:
Follow Step 1 through Step 3. Click on the Delete Command Button. Caution
should be used when deleting codes. If a code has been used and is subsequently
deleted from the codebook, all previous points of assignment to response passages
are also removed from the database.
Adding a new code:
Follow Step 1 and Step 2. Click on the Add Code Command Button.
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Method 2:
Accessing the codebook editing functions from the Coding Form:
Step 1: Go to the Coding Form.
Step 2: Select Modify Codebook from the Menu Bar. (See figure 6.5-4.)
Figure 6.5-4

Modifying Codebook in Coding Form

Step 3: A screen will appear prompting the user to enter a Codebook Password.
Enter the desired password and click on Continue. (See figure 6.5-5.)
Figure 6.5-5

Codebook Password
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Step 4: The Codebook Maintenance Screen will appear. Click the appropriate
command buttons to add new codes, delete existing codes, or edit the
current codebook definitions. Caution should be used when deleting
codes. If a code has been used and is subsequently deleted from the
codebook, all previous points of assignment to response passages are
also removed from the database. After changes to the codebook are
made, click Return to go back to the Coding Form and continue with the
coding process. (See figure 6.5-6.)
Figure 6.5-6

6.6

Codebook Maintenance

Exporting and Importing the Codebook

EZ-Text has the capability of exporting and importing codebooks. This feature allows
multi-site projects to create one universal codebook to be used by all sites. The researcher
responsible for the codebook can add, modify, or delete codes in the codebook, export the
codebook, and then send the codebook to the sites. Once the codebook is received, the
sites can import the codebook into their database.
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6.6(a) Creating a Codebook Export File
To create a Codebook Export file:
Step 1: Go to the Coding Form.
Step 2: Select Modify Codebook on the Menu Bar. (See figure 6.5-4.)
The Codebook Maintenance Screen will appear. (See figure
6.5-6.)
Step 3: Click on Codebook on the Menu Bar. Click on Create Codebook
Export File on the File Menu. (See figure 6.6-1.)
Figure 6.6-1

Create a Codebook Export File

Step 4: A screen asking for a file name will appear. Enter the file name (which
always has the .cdb file name extension) and click OK. (See figure
6.6-2.)
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Figure 6.6-2

Naming a Codebook Export File

6.6(b) Copying and/or Renaming a Codebook Export File
To Copy and/or Rename a Codebook Export File:
Step 1: Go to the Coding Form.
Step 2: Select Modify Codebook on the Menu Bar. (See figure 6.5-4.)
The Codebook Maintenance Screen will appear. (See figure
6.5-6.)
Step 3: Click on Codebook on the Menu Bar. Click on Copy or Rename
Codebook Export File on the File Menu. (See figure 6.6-3.)
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Figure 6.6-3

Copy or Rename a Codebook Export File

Step 4: A screen with two columns of fields will appear. The column on
the left displays a list of codebook export files from a Source
Folder, a list of Source Folders, and the Source Drive. The
column on the right displays a list of codebook export files from a
Target Folder, a list of Target Folders, and the Target Drive.
From the list of files above Source Folders, highlight the file to be
copied and/or renamed. (See figure 6.6-4.) If the file to be
copied does not appear in this list of Source Files, select the
appropriate Source Drive and Source Folder. To select a Source
Drive, click on the black arrow to the right of the Source Drive
field, and select the needed drive from the pull-down menu by
clicking on the drive. To select a Source Folder, scroll down the
list of Source Folders, and double-click on the folder needed.
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Figure 6.6-4

Selecting a Codebook Export File to Copy

Step 5: Select the folder, in the right-hand column, into which the
codebook export file will be copied (Target Folder). To select
the Target Folder, double-click on the top folder in the Target
Folder field. Scroll down the list of folders, and double-click on
the folder needed. If it is necessary to change the Target Drive,
click on the black arrow to the right of the Target Drive field, and
click on the appropriate drive. (See figure 6.6-5.)
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Figure 6.6-5

Selecting the Target Folder

Step 6: After selecting the Target Folder, type the name of the codebook
export file in the field under Target File Name. If you are
renaming the codebook export file, type in the new name ending
with a .cdb extension. Click on OK. A screen will appear to
inform the user that the file was successfully copied. Click on
OK. (See figure 6.6-6.)
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Figure 6.6-6

Naming the Codebook Export File to be Copied

Note: If the user wants to rename a codebook export file in the same folder, make sure
the Target Folder is the same folder as the Source Folder. (See figure 6.6-7.)
When a file is renamed, the original file will still exist. To delete the original file,
see section 6.6(c).
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Figure 6.6-7

Renaming a Codebook Export File in the Same Folder

6.6(c) Deleting a Codebook Export File
To delete a codebook export file:
Step 1: Go to the Coding Form.
Step 2: Select Modify Codebook on the Menu Bar. (See figure 6.5-4.)
The Codebook Maintenance Screen will appear. (See figure
6.5-6.)
Step 3: Click on Codebook on the Menu Bar. Click on Delete Codebook
Export File on the File Menu. (See figure 6.6-8.)
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Figure 6.6-8

Delete a Codebook Export File

Step 4: A list of previously-saved codebook export files will appear.
Highlight the name of the file to be deleted, and click on OK.
Alternatively, type the name of the codebook export file at the
prompt and click on OK. (See figure 6.6-9.) If the file to be
deleted does not appear in the list of files, select the appropriate
drive and folder. To select a drive, click on the arrow to the right
of the drive field, and select the needed drive from the pull-down
menu by clicking on the drive. To select a folder, scroll down the
list of folders, and double-click on the folder needed.
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Figure 6.6-9

Selecting a Codebook Export File to Delete

Step 5: After the file has been deleted, a screen will appear informing the
user that the file deletion was successful. Click on OK.

6.6(d)

Moving a Codebook Export File

To move a codebook export file:
Step 1: Go to the Coding Form.
Step 2: Select Modify Codebook on the Menu Bar. (See figure 6.5-4.)
The Codebook Maintenance Screen will appear. (See figure 6.56.)
Step 3: Click on Codebook on the Menu Bar. Click on Move Codebook
Export File on the File Menu. (See figure 6.6-10.)
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Figure 6.6-10

Move a Codebook Export File

Step 4: A screen with two columns of fields will appear. The column on
the left displays a list of codebook export files from a Source
Folder, a list of Source Folders, and the Source Drive. The
column on the right displays a list of codebook export files from a
Target Folder, a list of Target Folders, and the Target Drive.
From the list of files above Source Folders, highlight the file to be
moved. (See figure 6.6-11.) If the file to be moved does not
appear in this list of Source Files, select the appropriate Source
Drive and Source Folder. To select a Source Drive, click on the
black arrow to the right of the Source Drive field, and select the
needed drive from the pull-down menu by clicking on the drive.
To select a Source Folder, scroll down the list of Source Folders,
and double-click on the folder needed.
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Figure 6.6-11

Selecting a Codebook Export File to Move

Step 5: Select the folder, in the right-hand column, into which the
codebook export file will be moved (Target Folder). To select
the Target Folder, double-click on the top folder in the Target
Folder field. Scroll down the list of folders, and double-click on
the folder needed. If it is necessary to change the Target Drive,
click on the black arrow to the right of the Target Drive field, and
click on the appropriate drive. (See figure 6.6-12.)
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Figure 6.6-12

Selecting the Target Folder

Step 6: After selecting the Target Folder and file to be moved, click on
OK. A screen will appear to inform the user that the file was
successfully moved. Click on OK.

6.6(e) Importing a Codebook
An existing codebook associated with a database is replaced by using the Import
Codebook function available on the File Menu on the Interview Information
Screen. These features help project managers on multi-site studies ensure that the
same codebook is used by all sites.
To ensure this, the researcher responsible for the codebook should:
(1) Be the only person with knowledge of the Administration and
Codebook Passwords,
(2) Facilitate cross-site consensus regarding codebook revisions (e.g., via
conference calls or e-mail), and
(3) Distribute revised versions of the codebook file to each coder as
needed.
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Coders at each site can replace their old codebook with the revised version by
using the Import Codebook feature. To minimize confusion regarding which
codebook version is currently in use, a date and time field for the codebook is
automatically provided by EZ-Text. It is viewed by clicking on the About Menu
item on the Interview Information Screen.
To Import the codebook:
Step 1: Go to the Interview Information Screen.
Step 2: Click on File on the Menu Bar and select Import Codebook. (See
figure 6.6-13.)
Figure 6.6-13

Importing the Codebook

Step 3: A screen will appear with a list of saved codebooks from which to
choose. Highlight the desired codebook and click on OK. (See
figure 6.6-14.)
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Figure 6.6-14

6.7

Selecting a File for Codebook Import

Database Searches from the Coding Form

A search option on the Coding Form's Menu Bar assists in conducting Boolean searches
of the database. Searches are designed using combinations of ID numbers, open-ended
question numbers, and assigned codes. Search results can be printed, copied to a word
processor document, or viewed on screen. The search feature may be used to find and
replace inappropriately assigned codes. After coding is complete, it can be helpful for
selecting text passages to use in ethnographic case studies.
To perform a search:
Step 1: From the Interview Information Screen, select Coding on the Menu Bar.
Step 2: The Coding Form will appear. Select Search on the Menu Bar. This
will list two search options: setting up a new search and revising a
previous search. (See figure 6.7-1.)
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Figure 6.7-1

Search Function

Step 3: Define a search by Code, Respondent ID, and/or Question Number by
using the selection lists. (See figure 6.7-2.)
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Figure 6.7-2

Defining a Search

Note: Field 1 and Field 2 execute first. Field 3 searches from the results of Field 1 and
Field 2.
Step 4: Once the search is defined, click on the Execute Query Command
Button. The number of results will appear in the Results field. (See
figure 6.7-3.)
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Figure 6.7-3

Search Results

Step 5: To view the results, click on the Browse Command Button. While
browsing, use the Command Buttons, i.e., First, Previous, Next, Last, to
navigate through the results. (See figure 6.7-4.)
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Figure 6.7-4

Step 6:

Viewing Search Results

To print the results, select Reports on the Menu Bar and click on
Response Coding Report. (See figure 6.7-5.)
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Figure 6.7-5

Selecting Response Coding Report

Step 7: From the Print Preview Screen, click on the appropriate Print Command
Button. (See figure 6.7-6.)
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Figure 6.7-6

Printing Search Results
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Chapter 7 - EZ-Text Agents
The Agents Menu, located on the Menu Bar at the top of the Interview Information
Screen, guides the user through five different tasks:
(1)
(2)
(3)
(4)
(5)

7.1

Report Agent (printing data),
Data Export Agent (creating ASCII files),
Database Merge Agent (merging files),
Database Subset Agent (copying a subset of records to a new file), and
Spell Check Agent (spell check).

Printing Data with the Report Agent

The first item on the Agents Menu is the Report Agent. This agent implements a series of
step-by-step instructions for generating two types of reports. The first report shows all
the questions and responses for individuals chosen from a pull-down list of ID numbers.
The second report reorganizes the data to show the responses for all individuals to one or
more of the open-ended questions. Both reports can be either printed or previewed onscreen.
To preview or print the data:
Step 1: From the Interview Information Screen, click on Agents on the Menu Bar
and click on Report Agent. (See figure 7.1-1.)
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Figure 7.1-1

Report Agent

Step 2: On the first screen of the Report Agent, choose the type of report to
preview or print. Choose a report of either Responses by Respondent
IDs or Responses by Question Number. After making a selection, click
on Next. (See figure 7.1-2.)
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Figure 7.1-2

Report Selection

Step 3: On the next screen, select the desired Respondent IDs or Question
Numbers depending on the type of report. To select all of the
Respondent IDs or Question Numbers click on the double-arrow, or to
select one or more Respondent IDs or Question Numbers click on the
single-arrow. After making the selection, click on Next. (See figure 7.13.)
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Figure 7.1-3

ID Selection

Step 4: The third screen provides the option of previewing the report on the
screen before printing. Turn the screen preview on or off by
selecting/deselecting Preview Report, and then click on Finish. (See
figure 7.1-4.) If preview is chosen, the report will appear on the next
screen along with the option of printing by clicking on the appropriate
Print button. (See figure 7.1-5.) If preview is not chosen, clicking on
Finish will start the report printing.
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Figure 7.1-4

Turn Preview Report On/Off

Figure 7.1-5

Print Preview
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7.2

Creating ASCII Text Files and Numeric Matrices with the
Data Export Agent

The Data Export Agent is used to export information from the database in one of three
formats. The first format copies some or all of the data to an ASCII text file. This file can
be viewed in a word processing program or imported into other qualitative data analysis
software. The agent's dialog screens help users specify the desired content of the file by
requesting combinations of ID numbers, open-ended question responses, Interview
Information variables, and assigned codes along with their short definitions.
The second and third data export formats produced by the Data Export Agent create files
containing ASCII comma delimited or tab separated matrices. The matrix files can be
imported later into a spreadsheet or statistical software for further analysis. By use of a
common ID number, researchers might link EZ-Text matrices with other quantitative data
generated for the same respondents with another program such as SPSS® (e.g., merging
an EZ-Text matrix with a second file containing socioeconomic, medical, psychometric, or
other similar variables). In creating the matrices, users request combinations of ID
numbers, interview information variables, and codes assigned to open-ended question
responses. The comma delimited output file contains one row for each requested ID, and
one column for the selected interview information variables and codes. (See figure 7.2-1.)
Figure 7.2-1

Example of an ASCII Comma Delimited Matrix as Viewed in
Notepad
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Matrix cell values either contain the data that were entered for the individual information
variables, or they contain ones and zeroes which indicate whether or not a code was
assigned to an open-ended question response. Each column is labeled with the original
interview information variable name, or a slightly modified version of the code name used
in the codebook. When requesting coding data for more than one open-ended question,
EZ-Text places single letters (A, B, C) as a prefix to the code name. For example, if an
EZ-Text codebook contains three codes named CODE1, CODE2, and CODE3, each
code might be assigned to responses for either or both Question 1 and Question 2. Matrix
column labels for the two questions in this example would be ACODE1, ACODE2,
ACODE3, BCODE1, BCODE2, and BCODE3. Because codes in the codebook can be
no longer than seven characters, insertion of the single letter prefixes yields column labels
no longer than eight characters. Since the matrices may be imported into statistical
software, this convention corresponds to the eight character variable name limit within
programs such as SPSS® or SAS®.
To Export questions, responses, and assigned codes to a Text File:
Step 1: On the Interview Information Screen, click on Agents on the Menu Bar
and click on Data Export Agent. (See figure 7.2-2.)
Figure 7.2-2

Data Export Agent
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Step 2: On the first screen, select the first option: Export Questions, Responses,
and Assigned Codes to text file. Click on Next. (See figure 7.2-3.)
Figure 7.2-3

Selection of Data for Export

Step 3: On the second screen, select the desired Respondent IDs and click on
Next.
Step 4: On the third screen, select the desired Question Numbers and click on
Next.
Step 5: On the fourth screen, select the desired Interview Information Fields and
click on Next. (See figure 7.2-4.)
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Figure 7.2-4

Interview Information Field Selection

Step 6: The fifth screen provides the option of Exporting Assigned Codes and
Short Definitions. To enable this option, select the empty white box.
Click on Finish.
Step 7: Name the file to be exported. It is recommended that the file have the
“.txt” extension. Once the file is named, click on OK. To exit the fifth
screen, click on Cancel. (See figure 7.2-5.)
Figure 7.2-5

Name Export File
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To Export Interview Information and Coding Data to a comma delimited data file for
use with a statistical package:
Step 1: From the Interview Information Screen, click on Agents on the Menu Bar
and click on Data Export Agent.
Step 2: On the first screen, select the second option: Export Interview
Information and Coding Data to a comma delimited data file… Click
on Next. (See figure 7.2-6.)
Figure 7.2-6

Data Export Agent

Step 3: On the second screen, select the desired Respondent IDs and click on
Next.
Step 4: On the third screen, select the desired Question Numbers and click on
Next.
Note: As a result of the alphabetical prefix placed before the code name
(which can be up to seven characters), there is a limit of twenty-six questions
that can be exported at any one time.
Step 5: On the fourth screen, select the desired Interview Information Fields and
click on Next. (See figure 7.2-7.)
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Figure 7.2-7

Selection of Interview Information to be Exported

Step 6: On the fifth screen, select the desired Codes and click on Finish. (See
figure 7.2-8.)
Figure 7.2-8

Selection of Codes to be Exported
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Step 7: Name the file to be exported. It is recommended that the file have the
“.txt” extension. Once the file is named click on OK. To exit the fifth
screen, click on Cancel. (See figure 7.2-9.)
Figure 7.2-9

Name File to be Exported

To Export Interview Information and Coding Data to a Tab Separated data file for use
with a statistical package:
Step 1: From the Interview Information Screen, click on Agents on the Menu Bar
and click on Data Export Agent.
Step 2: On the first screen, select the second option: Export Interview
Information and Coding Data to a Tab Separated data file… Click on
Next. (See figure 7.2-10.)
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Figure 7.2-10

Data Export Agent

Step 3: On the second screen, select the desired Respondent IDs and click on
Next.
Step 4: On the third screen, select the desired Question Numbers and click on
Next.
Note: As a result of the alphabetical prefix placed before the code name
(which can be up to seven characters), there is a limit of twenty-six questions
that can be exported at any one time.
Step 5: On the fourth screen, select the desired Interview Information Fields and
click on Next.
Step 6: On the fifth screen, select the desired Codes and click on Finish.
Step 7: Name the file to be exported. It is recommended that the file have the
“.txt” extension. Once the file is named click on OK. To exit the fifth
screen, click on Cancel.

7.3

Merging Files with the Database Merge Agent

The third option on the menu is the Database Merge Agent. This agent is used to append
another EZ-Text file into a currently open database (e.g., merging files containing two sets
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of interviews, collected in two cities in a multi-site research project). The merge process
is successful only if two conditions are met:
(1) There is no overlap in the ID numbers used in the two files, and
(2) Identical template versions have been used to create the two files.
To ensure that data files created on separate computers can be merged, project managers
should assign a different ID number series to each interviewer. In addition, each
interviewer should check the date and time information for his/her copy of the database,
available under the About Menu on the Interview Information Screen. By comparing the
date and time of the last template modification, project managers can verify that all
interviewers have exactly the same revision on their computers before data entry begins.
To merge data:
Step 1: After opening one database, from the Interview Information Screen, click
on Agents on the Menu Bar and click on Database Merge Agent. (See
figure 7.3-1.)
Figure 7.3-1

Database Merge Agent

Step 2: On the first screen, select a different database file to merge into the
currently open database and click on Next. (See figure 7.3-2.)
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Note: Even though the two files being merged were created from the same template,
the two files being merged should have different file names. (e.g., file1.mdb and
file2.mdb.) It is necessary for both files to have the same file structure.
Note: If the codebooks in the two files are identical, users have the option to include
assigned codes during the merge. If this option is chosen and there is any
discrepancy between the codebooks, EZ-Text generates an error message and the
two files will not be merged. Users can verify that the codebooks are the same by
comparing the date and time fields for the codebooks in the two files (select About
Menu on the Interview Information Screen).
Figure 7.3-2

Selection of Database to be Merged

Step 3: On the next screen, select whether to merge coding data into the existing
database by clicking the selection box. Click Finish.

7.4

Copying a Subset of Records with the Subset Agent

The Subset Agent allows selection of a subset of the records and copies them to a new
EZ-Text database file. The database can be subset by Respondent ID or by Interview
Information.
Example of using the Subset Agent to subset by Respondent ID:
Step 1: From the Interview Information Screen, click on Agents on the Menu Bar
and click on Database Subset Agent. (See figure 7.4-1.)
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Figure 7.4-1

Database Subset Agent

Step 2: Click on the circle beside Respondent IDs and click on Next.
Step 3: On the second screen, select the desired Respondent ID numbers and
click on Next.
Step 4: The third screen lists subset options. Select whether to copy
the codebook to a new database, copy the coding data and the codebook,
or to copy neither. Continue by clicking on Next or to cancel by clicking
on Cancel.
Step 5: On the fourth screen, enter a file name for the subset database and click
on Finish. Finally, click on Cancel to return to the Interview Information
Screen. (See figure 7.4-2.)
Note: The new file containing the subset of the original record should be given a file
name different from the original database.
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Figure 7.4-2

Naming the Subset File

]
Example of using the Subset Agent to subset by Interview Information:
Step 1: From the Interview Information Screen, click on Agents on the Menu Bar
and click on Database Subset Agent.
Step 2: Click on the circle beside Interview Information and click on the Next
Command Button.
Step 3: On the second screen, select the Field to subset the data on and set the
Value to match on. To select the field, use the selection list by clicking
on the arrow to the right of the box and selecting the appropriate field
name. To set the value, type in the desired value for the field as it
appears on the Interview Information Screen. After typing in the value,
click on Next. (See figure 7.4-3.)
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Figure 7.4-3 Setting Field and Value to Match On

Step 4: The third screen lists subset options. Based on the first selection, a
category has already been chosen. Decide whether to continue by
clicking on Next or to cancel by clicking on Cancel.
Step 5: On the fourth screen, enter a file name for the subset database and click
on Finish. Finally, click on Cancel to return to the Interview Information
Screen.

7.5

Check Spelling with the Spell Check Agent

The Spell Check Agent checks the spelling within the text of one or more questions for
one or more Respondent IDs.
To check spelling:
Step 1: On the Interview Information Screen, click on Agents on the Menu Bar
and click on Spell Check Agent. (See figure 7.5-1.)
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Figure 7.5-1

Spell Check Agent

Step 2: Select the desired Respondent ID numbers and click on Next.
Step 3: On the second screen, select the desired Question numbers and click on
Finish. The Spell Check Agent will begin checking the text of the
questions selected.
Step 4: When the Spell Check Agent finds a misspelled word or a word not in
the Spell Check Dictionary, the Spelling Check Screen will appear
displaying the misspelled word. (See figure 7.5-2.) The Spelling Check
Screen displays six Command Buttons.
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Figure 7.5-2

Spelling Check

Ignore - ignores the misspelled word once, and the spell check
continues.
Ignore All - ignores the misspelled word for that entire spell check
session, and the spell check continues.
Change - changes the misspelled word to a word selected from the
dictionary or one of the suggestions. The first word selected from the
dictionary appears in the “Change To” box. Another word may be
selected by highlighting the word in the “Suggestions” box. If the
correct spelling of the word is not listed in the “Suggestions” box, place
the cursor in the “Change To” box and type the correct word. After
clicking on Change, the spell check continues. (See figure 7.5-3.)
Figure 7.5-3

Changing a Word in Spell Check

Change All - changes all of the words spelled like the misspelled word
for that entire spell check session, and the spell check continues.
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Add - adds the selected word to the Spell Check Dictionary, and the spell
check continues. Use caution when adding words into the Spell Check
Dictionary, because words cannot be removed from the dictionary.
Cancel - cancels the spell check session.
Once the spell check session is complete, a Spell Check Complete Screen will appear. (See
figure 7.5-4.)
Figure 7.5-4

Spell Check Complete

Note: As the misspelled words appear in the Spelling Check Screen, they are also
highlighted in the actual text of the question. The Spelling Check Screen can be
moved to see the context of the word in question by clicking on the bar at the top of
the Spelling Check Screen with the mouse and dragging the screen in any direction
until the highlighted word is visible.
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Chapter 8 - Import Text Feature
8.1

Importing Text Files with the Import Text File Feature

In most cases, EZ-Text users directly type responses into the Open-ended Questions
screens for their database (see Chapter 4). However, some users may wish to copy blocks
of text from other existing word processor documents. For example, this might include
copying portions of verbatim interview transcript files that were generated using a word
processor software program (e.g. Microsoft  Word, WordPerfect, etc.).
In the EZ-Text program, the Import Text File feature (accessed under the File Menu on
the Interview Information Screen) is used to select portions of text from an existing text
file and copy them to designated locations within an EZ-Text database. Note that in order
to use this EZ-Text feature, the original word processor file must be resaved as a text file
(i.e. an “ASCII”: or “DOS Text” file format; EZ-Text does not recognize internal formats
specific to files generated by many word processing software programs).
To import a text file:
Step 1: On the Interview Information Screen, go to the ID number
corresponding to the text file you wish to import.
Step 2: Under the File Menu, click Import Text File. (See figure 8.1-1.)
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Figure 8.1-1

Import Text File Feature

Step 3: Select the Open File button, or, under the File Menu, select Open Text
File. (See figure 8.1-2.)
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Figure 8.1-2

Opening a Text File

Step 4: A list of previously saved text files will appear. If the file to be opened
does not appear in the list of files, select the appropriate drive and folder.
To select a drive, click on the arrow to the right of the drive field, and
select the needed drive from the pull-down menu by clicking on the drive.
To select a folder, scroll down the list of folders and double-click on the
folder needed. Once the appropriate file is selected, click on OK. (See
figure 8.1-3.)
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Figure 8.1-3

Selecting a Text File to Import

NOTE: The file you wish to select MUST be saved as an ASCII or DOS Text file.
EZ-Text 3.06 does not recognize other word processing formats. Save existing word
processing files (such as Microsoft Word and WordPerfect) as Text Only, return
to EZ-Text, and reload the text file.
Step 5: From the pull-down menu next to the Question No.: field, select the
question number for which you wish to import text. (See figure 8.1-4.)
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Figure 8.1-4

Selecting Proper Question Numbers

Step 6: Using the mouse, highlight the portion of text to be copied into the
response section for that question. (See figure 8.1-5.) Alternatively, users
can hold their Shift key down and use their keyboard’s arrow keys to
highlight a block of text.
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Figure 8.1-5

Highlighting Text to be Imported

Step 7: Click Save. EZ-Text automatically copies the selected portion of text
into the database.
Step 8: Continue onto the next question by clicking the Next Q. button at the
bottom of the screen, and repeat steps 5-7.
Step 9: When you have finished copying text for the current record, return to the
Interview Information Screen by clicking the Return button, or by
selecting Return to Main Screen under the File Menu.

8.1(a) Correcting a Mistake
EZ-Text’s Import Text feature allows for text to be efficiently copied into a single
question response from several places in the same text document. It does not
overwrite existing saved text, but adds new saved text to the end of the response.
Thus, to correct a mistake, it is not sufficient to simply re-highlight and save the
correct text to be copied.
To correct a mistake:
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Step 1: Return to the Interview Information Screen by clicking the Return
button.
Step 2: Click the Questions button.
Step 3: Go to the question number to be corrected by clicking the Goto
Question button and selecting the question number from the pulldown menu.
Step 4: Highlight the entire response and press delete on the keyboard.
Step 5: Click Return to Main. From the Interview Information Screen
under the File Menu, click Import Text File.
Step 6: Until a text file or the database is closed, EZ-Text will keep the
last text file open. Go to the desired question number by using
the pull-down menu at the bottom of the screen. Highlight the
appropriate text and click Save. Continue highlighting and saving
text for additional questions as usual.

109

Chapter 9 - Reliability Agent
The Reliability Agent is designed to help users assess and improve intra- and inter-coder
reliability. EZ-Text is unique in this regard, since very few other qualitative software
programs offer any assistance in assessing reliability. These new EZ-Text functions are
based on new methods previously developed for coding data from semi-structured
interviews (Carey et al. 1996). Users can select a random subset of respondents from a
database. The data subset is copied to two new files, which two coders then
independently code using the same codebook. (The same coder would use both files to
assess intra-coder reliability.) After the two coders have completed their work, the
Reliability module compares the two files and generates reports. The report generated by
using the first comparison method helps investigators identify which open-ended questions
or respondents have poor coding reliability. The second comparison method generates a
kappa statistic for how the two coders use each code in the codebook. This helps identify
which codes have poor reliability. Researchers can use the reports to improve their
codebook, focus additional attention on hard-to-code portions of the database, or address
further coder training needs. After several iterations of reliability testing and codebook
improvement, researchers can use the reports to estimate the final level of achieved interor intra-coder reliability.

9.1

Creating Comparison Files for Reliability Tests
Step 1: The first step in using the Reliability Agent is to create two comparison
files. Select Create Comparison Files under Reliability on the Menu bar
on the Interview Information Screen. (See figure 9.1-1)
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Figure 9.1-1

Creating Comparison Files

Step 2: A dialog screen is opened which asks the user to specify how many
respondents the user wants EZ-Text to randomly select and copy to the
two comparison files. This number is constrained by the number of
records in the database. After entering the desired number, click Next.
(See figure 9.1-2)
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Figure 9.1-2 Selecting the Number of Respondent Records to be Copied

Step 3: Specify the name and path for each of the comparison files. To make file
management easier, the two files can be named after each coder and
iteration number. For example, the comparison file names
“mary_no1.mdb” and “john_no1.mdb” might indicate the names of the
coders and also show that the files are to be used for conducting the first
inter-coder reliability test. When the names and paths for the files have
been selected, click on Finish. (See figure 9.1-3)
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Figure 9.1-3 Naming Comparison Files

Step 4: A screen will appear informing the user that the two comparison files
have been successfully created. Click on OK, and then on Cancel to
return to the Interview Information Screen.
Step 5: Each coder should then independently code his or her files using the same
codebook.
Note: In order to make meaningful reliability comparisons, coders should not alter the
data or the codebook copied into each of their comparison files. The only
difference between the two files should be the way in which the two coders have
assigned the codes to the identical set of responses using the same codebook. EZText includes several internal checks to help ensure that these conditions are met.
This helps prevent meaningless or invalid comparisons (e.g., the two coders use
different codebook instructions, or they use responses from different sets of
respondents).

9.2

Running the Reliability Comparison

After the two coders have independently coded their files, the files can be compared to
assess the degree of agreement. EZ-text provides two different statistical methods for
assessing reliability.
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9.2(a) Method 1: Comparison of Sets of Codes Assigned by Both Coders to
the Same Set of Responses
This method pinpoints which questions or respondents in the database have
poor coding reliability. To do this, EZ-Text compares the sets of codes
that each coder has assigned to each open-ended question response in the
comparison files (see Carey et al. 1996 for an example of an application
using this technique). For example, suppose that a coder named Mary
assigned CODE1, CODE2, and CODE3 to the response for open-ended
question 1 for respondent ID 1000. A coder named John also assigned
CODE1, CODE 2, and CODE3 to the same response for the same
respondent. EZ-Text counts this situation as an “agreement”. However, if
John had only assigned CODE1 and CODE3, or has assigned an additional
CODE4 to this response, EZ-Text would count these situations as
disagreements. For the purposes of computing reliability statistics, EZText treats any discrepancy in how the two coders assign sets of codes to a
response - no matter how small - as a disagreement. This procedure is
intended to yield a statistically conservative estimate of reliability.
The comparison process is repeated for all the responses selected by the
user (i.e., the number of selected respondents multiplied by the number of
selected questions). EZ-Text generates an output summarized by each
respondent ID number and each open-ended question number. In addition,
the EZ-Text reliability output provides an estimate of overall reliability by
combining the results from all the selected questions and respondents.
The output can be used to identify which open-ended questions and which
respondents have the lowest coding reliability levels. Subsequent coding
improvement efforts can focus attention on the data from these difficult-tocode questions and respondents. After developing a final version of the
codebook, both coders should recode their files; generation of another
reliability report will provide the final level of agreement achieved in this
study.
Step 1: Select the Run Reliability Comparison item from the Reliability
Menu on the Interview Information Screen. (See figure 9.2-1)
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Figure 9.2-1 Running the Reliability Comparison

Step 2: The user is asked to provide the names of the comparison files.
Type the name and path of the desired files, or browse other
choices by clicking the Browse button. Once the desired files
have been selected, click Next. (See figure 9.2-2)
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Figure 9.2-2 Selecting Comparison Files

Step 3: The user is then asked to select a reliability method. Click the
selection button to the left of the Compare set of codes assigned
by the two coders to responses field. Click Next. (See figure 9.23)
Figure 9.2-3 Selecting Comparison Method #1
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Step 4: The next screen asks the user to specify which questions he/she
wishes to compare. Select all questions at once by clicking on the
button, or each question individually by clicking on the
button . To deselect a question, highlight that question
and click the
button, or deselect all questions at once by
clicking the
button.
Step 5: Click on Finish once the desired questions have been selected.
See section 9.3 for instructions on how to view and print the
reliability reports.

9.2(b) Method 2: Comparison of How Two Coders Use Each Code Across
the Same Set of Responses
The second reliability method compares how each coder has used each
code across the responses. EZ-Text constructs a 2 x 2 contingency table
containing four cells showing whether each coder assigned or did not
assign a specific code to the set of responses. For example, suppose that a
user wants to see how coders Mary and John used CODE1 across 200
response passages (e.g., responses to 20 open-ended questions collected
from 10 respondents). There are two agreement, or concordant cells: the
upper left cell shows the number of times both coders assigned the code,
and the lower right cell contains the number of times both coders did not
assign CODE1 to the responses. The two discordant cells indicate the
number of times CODE1 was assigned by one coder but not the other. The
sum of all four cells is equal to the total number of response passages (in
this example, the sum is 200).
A deceptively simple measure of agreement for how CODE1 is assigned
would be the proportion of times the two coders agreed (i.e., in this
example, the sum of the two concordant or agreement cells divided by
200). However, simple proportions do not take into account that some of
this agreement may occur due to chance (Gorden 1992: 184-185).
Therefore, the proportion of agreement is a biased overestimate of the
agreement of how two coders have assigned CODE1.
To correct for this problem, the kappa statistic is a more appropriate
measure (see Carey et al. 1996 for an example of an application using this
technique). In general, kappa can be thought of as the amount of
agreement between two coders after statistically adjusting for agreement
due to chance. A kappa value of 1.00 indicates perfect agreement. A
value of 0.00 indicates no agreement beyond chance, and kappa takes on
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negative values as low as -1.00 when there is less agreement than would be
expected by chance (Fleiss 1981).
Ideally, researchers will want the kappa scores calculated for all the codes
in their final codebook to be as close as possible to 1.00. In the study
conducted by Carey et al. (1996), final inter-coder reliability kappa score
values for 135 out of 152 codes present in the final codebook fell between
0.90 and 1.00. Of these 135 codes, 126 had a kappa value exactly equal to
1.00, which indicated complete agreement between the two coders.
Users may obtain kappa statistics for any combination of codes present in
the codebook in the two comparison files. After instructing EZ-Text which
codes, respondents, and questions to include in the calculations, EZ-Text
generates an on-screen report that shows the following results for each
code: the simple percent agreement between the two coders, the amount
of their agreement estimated to be due to chance, the kappa statistic, and
the standard error for kappa. If desired, the 2 x 2 table can be viewed on
screen. A report summarizing these results can be printed.
The results can be used to identify which codes have the poorest reliability.
In many cases, simple changes in the codebook can ameliorate the
problems (e.g., clarify ambiguous code definitions, remove duplicate or
overlapping codes, clarify coder training misunderstandings, etc.).
Step 1: Select the Run Reliability Comparison item from the Reliability
Menu on the Interview Information Screen.
Step 2: The user is asked to provide the names of the comparison files.
Type the name and path of the desired files, or browse other
choices by clicking the Browse button. Once the desired files
have been selected, click Next.
Step 3: The user is then asked to select a reliability method. Click the
selection button to the left of the Compare how the two coders
assigned each code across responses field. (See figure 9.2-4)
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Figure 9.2-4 Selecting Comparison Method #2

Step 4: The next screen asks the user to specify which questions he/she
wishes to compare. Select all questions at once by clicking on the
button, or each question individually by clicking on the
button . To deselect a question, highlight that question
and click the
button, or deselect all questions at once by
clicking the
button. Click Next.
Step 5: The next screen asks the user to specify which codes are to be
compared. Select the codes in the same manner as questions are
selected in Step 4 above.
Step 6: Click on Finish once the desired questions have been selected.
See section 9.3 for instructions on how to view and print the
reliability reports.
Step 7: To view the 2 x 2 contingency table (see figure 9.2-5) discussed
at the beginning of the section for a particular code, double-click
on the row containing the code to be viewed. Click Return to
return to the Kappa Summary Screen.
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Figure 9.2-5

Viewing the 2 x 2 Contingency Table

Note: It sometimes happens that the distribution of cell values in the 2 x 2 contingency
table fall into one cell. When this occurs kappa cannot be calculated using the
formula. Instead, since this is a boundary condition, the occurrence must be
handled by definition of the particular condition. Specifically,
•

If all the cell values fall into either one of the two concordant cells (i.e. all
in the “Yes-Yes” or the “No-No” cells in figure 9.2-5), the two coders are
in complete agreement. Kappa is 1.0 by definition. (Fleiss, 1981)

•

If all the cell values fall into either one of the two disconcordant cells (i.e.
all in the “Yes-No” or the “No-Yes” cells in figure 9.2-5, the two coders
are in complete disagreement. Kappa is -1.0 by definition. (Fleiss, 1981)

Or

When either of the two foregoing cell value patterns occur other results cannot be
calculated in addition to kappa. These are the “% Due to Chance” and the
“Standard Error” of kappa. In this circumstance, “Not Applic” is entered in the
appropriate column of the Kappa Summary Report. (Figure 9.3-2)
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In other circumstances, all of the cell values may fall into the two cells within a single row
of the 2 x 2 table or into the two cells in a single column of the 2 x 2 table. When this
occurs, the value of kappa is zero (0) and the standard error is zero (0).

9.3

Viewing and Printing Reliability Reports

After running the reliability comparison, EZ-Text computes the reliability statistics and
displays them automatically. The reliability statistics are presented differently for each
method.
Note: WARNING Computation of these reliability statistics and reports places
considerable demands on a computer’s processing capabilities. Keep in mind that
many EZ-Text database files can be very large, and heavy statistical demands may
exceed resources available on less powerful computers. Users with weak
computer hardware may experience difficulties or lengthy delays. If problems
occur, users should try dividing the task into smaller less demanding tasks (e.g.,
instead of asking the computer to generate kappa statistics for 300 codes across
two large comparison files, request the same results in three groups of 100 codes).

9.3(a) Viewing and Printing Reliability Reports for Method 1
Step 1: Click Finish after question numbers to be compared have been
selected. EZ-Text will display the Reliability Report Print
Preview Screen automatically. (See figure 9.3-1)
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Figure 9.3-1 Reliability Report Print Preview Screen

Step 2: Use the scroll-down bar to view the rest of the first page of the
reliability report. To view subsequent pages, click Next Page.
Step 3: To print the current page, click Print Page. To print the entire
report, click Print All.
Step 4: Click Cancel to go back to the previous screen (Step 3: Select
Open-Ended Questions). Click Cancel again to return to the
Interview Information Screen.

9.3(b) Viewing and Printing Kappa Summary Reports for Method 2
Step 1: Click Finish after codes numbers to be compared have been
selected. EZ-Text will display the Kappa Summary report
automatically. (See figure 9.3-2)
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Figure 9.3-2 Kappa Summary Report

Step 2: To print the Kappa Summary Report, click Print Report.
Step 3: To return to the previous screen (Step 4: Select Codes to
Compare), click Cancel. Click Cancel again to return to the
Interview Information Screen.
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